USBTiny-MKIl programozo

Software telepités

Miutan elkészitettiik a programozdénkat és az hibatlanra sikerlt (forrasztasok, 6sszes atkotés
—via — megléte, szemrevételezés legalabb 12x-s nagyitoval, kilonos tekeintettel a GTL
szintilleszt6 labai kozotti terilet ellenbrzése, stb ...) elméletileg azonnal miikddGképes
allapotban kell lennie. Ezért egy USB kabel segitségével azonnal csatlakoztatjuk a
szamitégéphez. Mivel még egy szliz processzorrdl van sz, ezért maga az AT90USBxxx
jelentkezik. Mivel a gépnek fogalma sincs, hogy mivel van dolga, ezért ezt latjuk az
eszkozkezel6ben: ismeretlen eszkoz. Viszont ez egy nagyon jo és megnyugtato hir. Mivel igy
mar biztosak lehetlink benne, hogy a processzor mikodik és az USB rész szintén, mivel létre
_ _ jott a kapcsolat a programozé és a PC kozott. Ez mar fél

-2 Billentylizet . (s .

) Bluctooth-radiék siker, a fele mar mikédik. llyenkor az egyik LED-nek

b e DVD/CD-ROM-meghajték sem kell vilagitania. Ha netdn a Win szeretné a

> -l Egérvagy egyéb mutstéeszkoz  meghaijté software-t telepiteni, ne hagyjuk neki, mert

4-5 Egyéb eszkazok

: teljesen felesleges. Feltéve, ha ez az elsé telepitésink,
..l AT90USB162 DFU

» P Halézati kartyak
. .% Hang- video- ésjatékvezérisk  |€pés, hogy telepitjik a FLIP-t, amivel életet lehellink a

- IDE ATASATAPT vezerlok programozonkba. Ez egy JAVA alapu programozé

mert kildnben ugyis felismerte volna. A kovetkez§

software, amivel az 6sszes nativ USB-s Atmel processzort tudjuk programozni, ugyanis
ezekbe mar gydrilag taldlhatd egy bootloader. Itt mar egyébként lathatjuk a bootloader-t
mUikddés kozben, mivel mar felépitett egy kommunikacidt a PC-vel. Ezért tudja a processzor
tipusat. Most letoltjik a programot innen: http://www.atmel.com/tools/FLIP.aspx. Kivalasztjuk a
nekiink megfelel6t. Ha nem vagyunk biztosak benne, hogy a JRE mar telepitve van a gépiinkon, akkor

ezt ,FLIP 3.4.7 for Windows (Java Runtime Environement included)” toltjik le. Kezdjik el a
telepitést. Ha a JRE nincs telepitve, ezt [atjuk:

&) Application Setup Iil—li:—hj
Java Runtime Environment (s
Installation r\ 3 ]

Mo Java Runtime Environment could be found on your computer,

Click Install to start the installation of JRE 1.5.0.

Install l | Cancel



http://www.atmel.com/tools/FLIP.aspx

Végig megylnk a telepitésen. Viszont, ha a teljes csomagot telepitjlik, vagyis JRE-vel egyiitt,
akkor mindenképpen frissitsiik a JRE-t, mert ez mar nem a legfrissebb. Es érdekes médon, ha
a JAVA a hattérben frissit, a Flip hajlamos meglepetésszerien kilépni. Frissités utan stabil. A
telepités utan elballagunk ide:

s —.
Helyi lemez (C:) » Program Files » Atmel » Flip347 » ush »

arba = Megosztds erzel - fras Uj mappa
i Mév
J amdid
, iabd
ework ]
| UpdateDriver
| 88

ns
= atrnel_ush_dfu

&k | atmel_usb_dfu

Itt taldljuk ugyanis az USB meghajtét, hogy végre miikodjon az ligy. Ide csak azért jottink,
hogy lassuk, honnan kell telepiteni a meghajtdt. Az eszkdzkezel6ben jobb klikk az ismeretlen
eszkdzre AT90USBxxx, majd illeszté program frissitése. Itt kivalasztjuk, hogy mi keressiik meg
az illeszt6 programot. Tehat kijel6ljik a C:\Program Files\Atmel\Flip 3.4.7\usb konyvtarat és
hagyjuk, hogy telepitse az illesztét. Ha ez megtortént, ezt kell Iatnunk az eszkdzkezel6ben.
4§ Atmel USB Devices Innentdl kezdve, mar elérhetd lesz a Flip szamara is. Most
- Ll AT90USB162 mar fel tudjuk télteni az dltalunk kivalasztott firmware-t a

» .22 Billentylizet programozonkra. Itt mar lathaté, hogy talan egy kicsit
- £} Bluetooth-radick

> i} DVD/CD-ROM-meghajték

> }3 Egér vagy egyéb mutatdeszkoz

bonyolultnak tlin6 elGkészités utdn mar nagyon egyszer(
dolgunk lesz. Es valdban a firmware csere nagyon gyors.
Nem beszélve arrdl, hogy mar lathatd, hogy ha valaki egy
ilyen nativ USB processzorral szerelt aramkort tervez, egyaltalan nincs sziikség
programozora. De most hivjuk fel a Flip-t. Persze az aramkoriink tovabbra is ott figyel az USB
porton. Az els6 dolgunk, hogy rakattintunk a Chip ikonra, a bal felsé sarokban ,Select Target
Device” és a megjelend ablakban kivalasztjuk a programozandd chip tipusat. Hogy miért nem
ismeri fel magatdl, az szdmomra egy rejtély. Nem hiszem, hogy rettenetesen nagy problémat
jelentett volna, de hat a slampossagnak nincs hatara.



”
Device Selection ﬂj

Select a dewvice

ATI0CAMTZE -
ATI0CANTZ
ATI0CAMNES
ATO0ISEL1Z236
ATR0SELZ2E7

m;

AT20ISELGZ

ATAOSEESE

ATI0IUSEES T

AT20IUSES2

ATmegalaMl -

| ok || cancel |

.

Ezutdn a kommunikacids vonalat kell kivdlasztanunk. Ez az USB kabeles ikon. Itt
értelemszer(ien az USB-t valasztjuk. Ezek utan megnyitjuk a csatornat és ezt latjuk:

-
Ji; Atmel Flip _ e

File Buffer Dewice 3Settings Help

PSS ST EH S

Operations Flow FLASH Buffer Information ATIOUSELRZ

Signature Bytes Iﬁ IE Iﬁ Iﬁ

Size 1ZKB
@ Erase

Range 0x0 - 00

g Device Boot Ids 00 |00

Checksum 0xFF
@ [ Blank Check

Reset Before Loading Bootioader Ver. J1.0.5
@ Program HE?; File:

@[] verify A El
[— — —— — — 3 I
Fun [ Select EEPROM ] Start Application ] Reset

| | USE ON

Lathatdlag mindent felismert, amit csak kell. A kbvetkezd [épés az dltalunk vélasztott hex file,
vagyis a firmware betoltése. File -> Load HEX file ... vagy a megfelel6 ikonra klikkelve
betoltjik a HEX-t.



Ezt kell latnunk.

File Buffer Device Settings Help

~Operations Flow———

@ [V]Erase

@ [ Blank Check

@ Program

@ [V Verify

PSS ST

~FLASH Buffer Information————
Size 12KB

Range 0x0 - 0x29B5

Chedksum 0x148E03

Reset Before Loading

HEX File:
AVRISP-MKII_130303_togale_driver.|

10672 util bytes

AIMEL

i

Select EEPROM

= f‘v"‘
== %

~AT90USE162

Signature Bytes ISSTIE_FE
Device Boot Ids WW
Bootloader Ver, Il.U.E

Start Application Reset

|HEX file parsed.

IUSB ON

Aztan klikk a Run-ra. A programozas utdan minden zold.

Operations Flow————

@ [¥]Erase

@ []Blank Check

@ [¥] Program

%) Verify

~FLASH Buffer Information

Size 12KB
Range 0x0 - 0x29B5
Checksum 0x 148E03

Reset Before Loading

HEX File:
AVRISP-MKII_130303_toggle_driver.|

10678 util bytes

AIMEL

i

Select EEFROM

-
..0ads\USETiny M iled-130303\AVRISP-MKI_130303 le_driver.h L=l
J5; ..oads\| iny MEII'compi WA Rl L. _toggle_driver.hex
File Buffer Device Settings Help
PSS IS EH S
e -

AT90USE162

Signature Bytes ISSTIE_FE
Device Boot Ids WW
Bootloader Ver. |1.0. 5

Start Application Reset

I'u'eriﬁd PASS

| USB ON




Ezutan klikk Start Application ikon. Ezzel inditja a programot a processzorban. Ha az AVR
Studio még nem lett telepitve, azt tegyiik most meg. A programozét a telepités alatt
valasszuk le a PC-rél. A telepités utdn csatlakoztassuk a programozdét. A Reset gombjat ne
nyomkodjuk. Késébb bévebben, hogy miért. Azonnal felismeri, hogy Uj hardware és elkezdi
telepiteni az illeszt6 programot. Ha kész van, igy néz ki az eszkdzkezel6:

»-% Hang-, video- és jatékvezérdk
» g IDE ATA/ATAPT vezérlék

AE" Jungo

- L. AVRISP mkIl

2¥ WinDriver

- 2= Képeszkazok

. s Lemezmeghajtd

Mar fel is ismerte. Ez mar igazi sikerélmény. Es mar latjuk, hogy ég az egyik LED. Ez a LED
mindig ég, ha fut a programozé software. Inditsuk el az Atmel Studiot. A meniipont View ->
Available Atmel Tools alatt lathatjuk faradozasaink eredményét.

B stort Page - atmeistudio Bl IR

File Edit View WAssist{ ASF Project Debug Tools Window Help
AR S @ 6 R - -E-E R o
I PER®RY D g i A u b s ELES

Available Tools

Tools and Simulators Status

| W
il

T|He:c: |_j

In
¥
Tl

.EAURISP mkd (000200212345) Program enly Connected

b Simulator Connected




Ez azért mar valami. Es most egy gyors teszt. Viszont még jatszunk egy kicsit, hogy megértsiik
mit is csindlunk és mink van. Nyomjuk meg a programozon a RESET gombot és nézzik
mereven a képerny6t.

Available Tools

Tools and Simulators Status

. AVRISP mkl (000200212345) Program only Disconnected

. AVRISP mkl (000200312345) Program only Connected
\

b Simulator Connected

A 212345-s eszkozt levdlasztotta és csatlakoztatta a 312345-s eszkozt. Vagyis mostantél a
masik firmware él. Mégpedig a LibUSB-s firmware. Tehat dsszefoglalva:

AVRStudio Jungo Driver -> 212345 startnal 2x villog
AVRDude, BASCOM, LINUX LibUSB Driver ->312345 startndl 4x villog

Nyomjunk még egyszer egy RESTET, hogy vissza térjlink a Jungo Driver-hez. Ha netan a
Studio alatt véletlenil a LibUSB-s firmware-el szeretnénk emberkedni, nem térténik semmi,
csak hibajelentést kapunk. Tehat ne a hardware-linkben keressiik a hibat. Most pedig
vegylnk el6 valamilyen daramkort, amin tesztelhetjlik az aramkoérink masik oldalat. Az eddigi
visszajelzések szerint itt szokott problémas lenni az ligy. Az egyik Forum tarsunk majd egy
hétig kereste a hibat, ami végil is egy hidegforrasztas volt. Persze, hogy a GTL-nél. Ezzel csak
arra szeretném felhivni mindenki figyelmét, ha netan nem mukodne, hideg fejjel és
maodszeresen zarjunk ki mindent ami jé és ami marad, ott van a kutya eldsva. En egy
prébapanelen felépitett tranzisztor tesztert kotottem ra, ami egyébként is a kisérletez6
kedvemnek esett aldozatul.
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Aztan elballagunk az AVRStudioba, és ami most jon, az verziofiigg6. Meni pont Tools ->
Device programming. A felugré ablakban bedllitjuk a programozoénk tipusat, a célaramkoéron

talalhatd AVR chip tipusat, majd Apply.

Device Programming

I Tool Device Interface Device signature Target Voltage I

AVRISP mkl » | ATmega328P  « ISP = ||Apply| — @|
' N

Firmware Upgrade

AVRISP mkdlI firmware must be updated before continuing

On Tool 0On Disk
Firmware Version 114 116

Firmware Upgrade




Na, ez konkrétan ugy hidnyzott, mint hatunkra a pup. Frissiteni ugyanis innen nem tudunk.
Ez az eredeti Atmel programozdénak szol, ami teljesen mas processzort hasznal. Persze ha
vicces kedviinkben vagyunk, nyomhatunk egy Upgrade-t, amire elkezd méltatlankodni,
amugy nem torténik semmi, de tovdbb sem enged. Ezt ezzel a verzidval csindlja:

About AtmelSta d;— E H

ATMEL
STUDIO

6

Atmel Studio & (Version: 6.1.2562) hittp ./ Awwew atmel .com.’
22013 Atmel Comp.

All ights reserved.

Support: httpe//support atmel.com

05 Version: Microsoft Windows NT 6.1.7601 Service Pack 1 (Platform: Win3dZNT)

View Installed Components: [Shell V51X manifest T]

Installed Packages: Shell WS manifest - £.1 Copy to clipboard

Shell V5IX manifest (6.1)

Fackage details:
! Shell VSIX manifest
Wersion: 6.1

N Package GUID: baabteale-da7b-48c1-9b2a-cab2329d32ac :
Company: Atmel Coproration /Itl I IEL

b

Ha régebbi verzidtok van, azzal feltehetSleg megy. Ez valdszinlileg azzal lehet
Osszefliggésben, hogy a firmware 2013 marciusi verzid, az Atmel meg utana hozta ki ezt a
software csomagot. Tehat le kell errél az upgrade manidrdl szoktatnunk. Ezért el6szor
elballagunk Vezérl6pult -> Mappa beadllitdsai, majd Nézet fil és kivessziik a pipat az ,Ismert
fajl tipusok kiterjesztésének elrejtése” eldli négyzetbdl. Ezutan ide megylink:

lemnez (C:) » Program Files » Atmel » Atmel Studio 81 » tools » AVRISPmKI »

fras Uj mappa

0 Mév Madositds datuma  Tipus
, xml 20130514, 19%:36 Fajlmappa
| avrispmkiizml 2013.04.24,15:31 XML dokurnentum

|§ avrispmkii_fw.zip 2013.04.24,15:31 WinRAR ZIP archi...




Majd atnevezzik pl.: avrispmkii.zip_, hogy még véletlendil se taldlja meg. Ez ugyanis a gyari
programozdba valé firmware. Most vissza a Studio-ba és Ujboli probalkozas.

AVRISP miil (000200212345) - Device Programming + B - @llﬂ_ﬁj]

I Tool Device Interface Device signature Target Voltage

AVRISP midl v | ATmega328P  ~ [15P  ~ | 0:d E950F Read| 33V |Read| @

Interface settings ISP Clack

Toal infermation { 125 kHz

Device information The ISP Clock frequency must be lower than 1/4 of frequency the device is operating on.

Memories
Fuses

Lock bits

Production file

Getting Vtarget...OK

" B Getting Vtarget...OK

L =

Ha ezt latjuk, j6 a programozdénk. A Device signature -> Read és Target Voltage -> Read
gombot azért nyomjuk meg, hogy lassunk is valamit. A gyari programozd méri a célaramkor
fesziiltségét. A miénk nem. A 3,3V csak azért van hogy a Studio ne izguljon. Mindig ennyi,
legyen az a valdsagban barmi is. Most viszont csinaljunk is valamit.

‘8 - [E=)

-

AVRISP mikl (000200212345) - Device Programming

I Tool Device Interface Device signature Target Voltage I
AVRISP mkIl v | ATmega32ap v 5P | 0x1E950F Read| 33V |Read| @|
Interface settings Device
Teol information [Erase Chip v| [ Erase now |
Device information Flazh [32KEB) |
Memaries CAUsers\Pluto’\Downloads\W107K_EM_M168_24041 N\ TransistorTester.hex v | |
Fuses Erase device before programming .

[¥] Verify Flash after programmin Program | [ Verify | [ Read.. |
Lock bits prog 9
EEPROM (1KE
Production file (LKE)
ChUsers\Plute’\Downloads\W107K_EN_M168_24041 N TransistorTester.eep A |
‘u"erify EEPROM after programming Rronean | [ Mesiby | [ fesde |
Getting Vtarget...OK

i |
(+] ok




Kivalasztjuk a HEX-t amit be szeretnénk égetni a célaramkorbe, ha van EEPROM fajlunk akkor
azt is és kattintunk a Program gombra.

AVRISP mkIl (000200212345) - Device Programming 49 - R
|I Tool Device Interface Device signature Target Voltage I
AVRISP mkll v | ATmega328P v |Isp | 031 E950F Read| 33V |Read| @|
Interface settings Device
Tool information [Erase Chip v| [ Erase now |
Device information Flash (32KE)
L
Memaories CA\Users\Pluto\Downloads\W107K_EN_M168_240413\TransistorTester.hex - El
Fuses Erase device before programming -
P Vi Read...
Lock bits Verify Flash after programming a0 ] [ erify | [ _ |

EEPRCM (1KE)

Production file

CaUsers\PlutohDownload=s\W107K_EN_M168_240413\TransistorTester.eep - |
[¥] Verify EEPROM after programming Brencn | [ ity | [ Beade |
Erasing device... OK
Programming Flash...OK
Verifying Flash...OK
L] L

(~] Verifying Flash..OK

Ha ezt latjuk, hatraddliink és megiszunk egy sért! Ugyan ez az EEPROM féjlal is, ha van. Es
ezzel készen is vagyunk a Jungo-Driver résszel. Itt végil is akdr le is allhatnank, mivel
barmivel is készitink HEX-t, ha a Studio nyitva van, egyszer(en be tudjuk égetni a
segitségével. Mi viszont tovabb megylink. Mindenek elétt kell egy LibUSB driver. Innen
tudjuk letolteni: http://sourceforge.net/projects/libusb-win32/?source=directory Ha megvan,

kicsomagoljuk. A programozé mindenképpen legyen csatlakoztatva a PC-re és a RESET gomb
megnyomasaval valtsunk at a LibUSB-s firmware-re. Ellenérizziik, hogy az atkapcsolas utan valéban
4x villognak a LED-k. Ha ez megvan, felhivjuk ai inf-wizard.exe-t, és végigmegylink a telepitésen.

Letaltések » libusb-win32-bin-1.26.0 » bin »

Tyitas Megosztas ezzel = fras l.:l_i mappa

-~

Mév Madositas datun
. amdad 20120117, 8:40
. i34 20120117, 8:40
. xB6 20120117, 8:40

inf-wizard.exe 2012.01.17. &:40

. libusb-win32-bin-README. et 20120117, 8:39


http://sourceforge.net/projects/libusb-win32/?source=directory

Ha megvagyunk, az eszkozkezelSben ezt latjuk:

4§ Atmel USB Devices
. L. AVRISP mkI
» 2= Billentydzet
- -£) Bluetooth-radick
» 1) DVD/CD-ROM-meghajtak
: }E!, Egér vagy egyéb mutatdeszkaz
-EF Halézati kartydk
-%| Hang-, video- &s jatékvezerldk
g IDE ATA/ATAPT vezérldk
a-EF Junge
L ¥ WinDriver
X5 Képeszkazak
<= Lemezmeghajtd

CRE RS RS

"

T

"

A programozoénk ,kijott” a Jungé Driver aldl és megjelent az ,, Atmel USB Devices” alatt. igy
mar tudjuk haszndlni LINUX és AVR Dude alatt is. Es most ugrik a majom a vizbe, mert idaig a
BASCOM nem mindegyik firmware verziéval volt hajlandé egylttmikodni. Most ez egy demo

verzio:
i Bl
About @
Compiler wversion : 2.0.7.5
Compiler build : 2.0.7.5.003
IDE wversion 1 2.0.7.5.003
Serial number 1 Serial DEMO
Windows 05 ! Windows 7 Ultimate
Windows 5P ! Service Pack 1
Company :
Cwner : Pluto
Windows dir : Cr\Windows
Lpp data dir : Ci\U=sers'\Pluto'\hppDhata'\Local\M
¥ML data dir : Ci\U=sers'\Pluto'\hppData'\ Roaming
System dir : Cr\Windows\system32
Support : supportimeselec. com
52 Copy
LS -]

Tehdat minden erre vonatkozik. Régebbi verzidkkal nem teszteltem. Legel8sz6r megnézziik a
programozonkat az Options -> Programmer menipont alatt.



-

BASCOM-AVR Opticns

| Enmpilerl Eu:ummuniu:atiu:unl Envirnnmentl

5imulatu:ur| F'TDQTEIITIITIET| Mu:unit-:url F'rinter|

[ Program after compile

Pragrarmmer [ S Bprog Programmer £ &%F [SP mkl| V]
Flay zound
[] Eraze waming [] &1t Flash Aot erify [] Upload Code and Data

[T] Set focus to terminal emulator after programming

COM-portt | oy v|  [C)Da not setISP clock frequency
Clock 125000 »  []avRISP protocol

Timeout USE 100 [¥] UsE

Timeout 5 ernial 100

7o

L

0 az. Aztan elSvettem egy dugaszpaneles 2313-t. Mégpedig azért, mert a demé verzidban,

ha jol emlékszem 4kByte a hatdr. Nehogy az okozzon a végén problémat. Menipont Program

-> Send to Chip -> Manual és ismertesstik fel vele a Chipet.

Fhe Elektor / mkI compatible Programmer

= | B - |

File Buffer

Chip .

@ PHe T TEE

Chip ATtinyZ2313 Flazh size 2 kB

EEFPROM zize

128 Bytes

00|01 02|03 |04 |05 | 08| 07 | 02| 09| 04| o8 |oc| oo oE | oF |

000 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
010 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
020 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
030 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
040 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
050 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
nen |Fe (FE EF (FE IFF (EF (FE [FE (FF EF [FE (FF FF (FE FF EF

© ATtny2313, FLASH : 2045, EPROM : 128
D Chip D 1ET0A
B AVRISP MEZ detected

FileM ame FLASH : 2 KB

EEPROM : 128 Butes

L

Na, ez teljes siker. Most kiolvassuk a Chip tartalmat, mert az 6rdég nem alszik.
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L9

i Elektor / mkll compatible Programmer

ESREER )

File Buffer Chip
PrPHe ¢« FF w8 B,

Chip ATtinp2313 Flazh size 2 KB

EEPROM zize

128 Bytes

o001 |02 |03 04|05 | 08 |07 |08 |03 | 0a o6 | oc | oo oE | oF |

000 jCo 12 /9518 35 15 9518 9515 95 18 9518 95 15

010 |95 15 /9518 95|15 95 18 9513 95|19 95 18 95 18 s+ s s s s
020 |95 18 95 18 95 18 ED &F BF 80 EB C8 EA E0 2E 4E s o s ZoTECef M
@2? DD 2E 5D 95 AS BY 84 2E 08 7F 87 BF 84 E1 83 "], K24
040 127 33 BD 81 BD 91 EV EE EOFOEE AO EDBO 27 88 ™ girdc ™

050 33 8D 97 31 F7 E9 24 66 EF 7F BE 71 34 95 B3 92 “T-1-&¢fdlqi-}.
NN IF4an (27 (89 (RRA? (CFIFR 94 (FAICFFF (97 31 (F7 F1 8% Bl =1 =4

E N

&) FLASH Code read into buffer
9 Buffer read
) VRIS MEZ detected

FileM ame FLASH : 2 KB EEPROR : 128 Butes

Ez is m(ikodik. Majd teljes torlés és Ujra irds.

-

L9

i Elektor / mkl compatible Programmer

ESEER™X)

File Buffer Chip
PPy 6« FF«TH0E,

Chip ATtinp2313 Flazh zize 2 KB

EEPROM zize

128 Bytes

000 [CO12 9518 95 12 95 18 /95 1295 12 95 12 95 12 Boess s+
@95 18195 18 /95 18 /9518 95 /18 9518 /95 18 95 18 +s s e s e
020 13518 95 18|35 158 ED 8F BF 8D EB C5 EA EOD 2E 4E +» s+ iZiTeleiN
030 |27 DD ZE 5D|35 A8 BY 84 |2E 08 7F |57 BF 54 E1 85 A
040 |27 33 BD/31 BD 31 EV|EE EO FO EE &0 EOD BO 27 83 "™ girdc r
050 |93 8097 3 F7 E9 24 65 EF 7F BB 71 94 95 B3 82 “T-1+E$fd g3+,

nEN IFA 19N 27 (A9 RRA? ITFIFR 194 [FR CFIFF 97 191 F7 (F1 &%= Bl =124

i 122 bytes written to FLASH
D AVRISP MKZ detected
D 129 bytes wiitten to FLASH

FileM arme FLASH : 2 KB

EEPROM : 123 Bytes

Es igy kijelenthetjiik, hogy m(ikddik BASCOM alatt is.

A végére hagytam a programozdonak egy olyan tulajdonsagat, ami mar tényleg csak hab a
tortan. Ez pedig a ,,RESCUE_CLOCK”. Ami annyit jelent, hogy a PC6(OC.1A/PCINTS8) labon
allandé 4MHz taldlhatd, arra az esetre, ha a célaramkoriinkben tanyazé AVR biztositék bitjeit

sikerilt ugy beallitani, hogy csak kils6 orajelre indul. llyenkor csatlakozunk az XTAL1 Iabra és



ott adjuk neki a jelet. Viszont tigyeljlink arra, hogy ilyen esetben a programozé — vagyis SPI —
6rajel csak 125kHz legyen, mert csak igy biztosithaté a stabil m(ikodés. Az altalam
megépitett programozdén a mérém 3,97MHz drajelet mutat. Igy néz ki a szképon:
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A bedllitas: 5V/div és 0.2us/div. Azért arra vigyazzunk, hogy itt 5V jatszik. Egy
célaramkorben, ahol esetleg csak 3,3V vagy akar 2,7V taldlhato, ott esetleg zokon veszi az
AVR. Ha sajat magunk forditjuk a firmware-t, a config.h-ban van egy lehet6ség a 4MHz-s jelet
atirdnyitani a PD5(XCK/PCINT12)-s labra (#define XCK_RESCUE_CLOCK_ENABLE), ami annyit
tesz, hogy az drajelet a szintillesztén keresztil zavarjuk. Akkor viszont megjelenik a PDI és TPI
csati labain. Ezt mélyebben nem tanulmanyoztam. Akinek van kedve, az kivesézheti.
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